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Tips, Tricks & Techniques (submitted by Howard Lewis) 
 
Creating a Windows 7 system repair disc 
When setting up a new Windows 7 system, one of the options presented is to create a System Repair  disc. It 
is always a good idea to perform this task, but if you do not do it at system setup, you can always do it later.  
 
1. Press Start button, type backup 
2. Select Backup and Restore and press Enter. 
3. In the left pane, click Create a system repair disc, and then follow the steps. If you are prompted for an 

administrator password or confirmation, type the password or provide confirmation. 
4. Select a CD/DVD drive and insert a blank disc into the drive. 
5. Select Create disc. 
 
If you are requested to insert a Windows install disc, the files needed to create the system repair disc are not 
on your computer. Insert a Windows 7 install disc at that time. 
 
Using a Windows 7 System Repair Disc 
If you are having problems with your Windows 7 system, you may need to use the System Repair  disc that 
you created when you setup your system. To use the System Repair disc: 

Insert the System Repair disc into your CD or DVD drive. 

Shut your computer down. 

Start up your computer. 

If you are prompted, press any key to start the computer from the System Repair disc. 

Choose your language settings, and then click Next. 

(Continued on page 3) 

Useful, useless and strange Web Sites (in no partic ular order) (submitted by Howard Lewis):  
 
http://www.drive-ins.com/ 
If you yearn for the old days and enjoyed going to drive-in movies, this site lists those drive-in theaters that 
are still open. You can locate the one closest to where you are. (Hint, there aren’t any very close to Midland.) 
 
http://tinyurl.com/4f2f6hl 
When you buy bottled water it is expensive. You expect the water to be clean, pure and better than your tap 
water. But that isn’t necessarily true. This site offers a report on what they found out about bottled water. 
 
http://tinyurl.com/635unut 
So you think you’ve learned how to use Windows. Well, things may be changing! This is a video demo (put 
on by Microsoft) this last spring of the new interface with Windows 8. I think this is a pre-Alpha version so it is 
very preliminary, but it will give you an idea on what Windows 8 may look like. 
 
http://tinyurl.com/3ov7bqx 
This video documents the changes in the upgrade process of Windows from Windows 1.0 all the way  
through to Windows 7. They start with a virtual machine running MS DOS 5 and install Windows 1.0. From 
there they continue to perform upgrades through all of the major versions of Windows to Windows 7. 
 
http://tinyurl.com/yk6lqa4 
Now for a little humor. Watch this funny video of a free photo booth with an attitude! 
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Select a recovery option, and then click Next. 

Follow any prompts which may follow. 

Once the repair process is completed, you will need to restart your computer and remove the CD or DVD 
from the drive. 
 
If your computer isn’t configured to start from a CD or DVD, check the information that came with your 
computer. You might need to change your computer’s BIOS settings. 
 
Change the Mouse for Left-Handed Users in Windows 7  
Normally the mouse is configured for right-handed users in Windows. This makes using the mouse more 
difficult for a person who is left-handed. You can easily change the mouse settings to allow a left-handed 
user to use the mouse more effectively. To change the mouse settings in Windows 7 for left-handed 
users: 
 
1. Click Start. 
2. In the search box, type mouse and press Enter. 
3. Select the Buttons  tab. 
4. Under Button configuration , Select the Switch primary and secondary buttons option. 

Click OK. 
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Add Text on a Photo in Word 2007  
By Lynn Page, Editor, Crystal River Users Group, Florida, www.crug.com 
December 2010 issue, CRUG newsletter, newsletter (at) crug.com 
 
When creating a document it may be useful to place text with or on top of a photo. You could create a new 
photo with the text in a digital photo editing application and then save it for use. But if you will just use that 
image once why go to the bother. Within Word 2007 you can add the text on top of your photo using either 
WordArt or a text box.  Which method to use depends on the effect desired. For text that is short and an 
interesting stylized look is what you want WordArt is a good option. For plain and simple text a text box 
can match the text to that in the rest of the document.  
 
Text Box on Top of a Photo  
Placing a text box on a photo can be as easy as inserting the photo, creating a text box and dragging the 
text box onto the photo. 
 
To add a photo to a document place the insertion 
point in the document where the photo is to be 
located and click the Picture icon in the 
Illustrations group on the Insert tab. Browse to the 
photo in the Insert Picture dialog box, select it and 
click the Insert button.  
 
 
To place a text box on the photo first create the text box. Place the insertion point on a line below the 
photo. Then in the Text group on the Insert tab, click text box and then click to select Simple Text Box. In 
the inserted Text Box type the text. To change the font or style of the text, highlight the text and then 
select the desired text formatting as with any other text. Drag the text box sizing handles to resize it as 
necessary. Finally click the outside edge of the text box and drag it to the proper location on top of the 
photo.   
 
 
 
 
 
 
 
 
 
The default Text Box will have white fill and a black 
border. For use over a photo you will probably want no fill 
color or border. With the Text Box still selected click Text 
Box Tools and on the Format tab, in the Text Box Styles 
group, click Shape Fill and select No Fill. Then click 
Shape Outline and select No Outline.   
 
With the Text Box you can add text on top of a photo and 
move the text to position it over the photo, but you can't 
rotate it. To be able to rotate the text or use text that is 
more stylized use WordArt.  

(Continued on page 5) 
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WordArt on Top of a Photo  
To place WordArt on the photo first create a Drawing Canvas. Place the insertion point in the document 
and then in the Illustrations group on the Insert tab open the Shapes drop down menu and click New 
Drawing Canvas.  
 
 
 
 
 
 
 
 
 
 
 
With the new drawing canvas still selected on the Insert tab, in the Illustrations group, click Picture. In the 
dialog box browse to and select the photo to use and click the Insert button. Again on the Insert tab, but in 
the Text group, click WordArt, select the style desired, and type the text. Select either piece of art and use 
the sizing handles to resize as desired. Click the outside edge of the WordArt to select it and drag it over 
the photo. Use the rotation handle to rotate the text to the angle that works best for the photo.   
 
Once the graphics are correctly formatted and positioned, group them. That creates a single graphic that 
can be moved or resized. The text stays with the photo. To create a group click the outside edge of the 
photo, press and hold the CTRL key, and click the edge of the WordArt so both items are selected. Under 
Drawing Tools, on the Format tab, in the Arrange group, click the arrow next to Group, and then click 
Group.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

(Continued from page 4) 
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Understanding System Restore 
By Vinny La Bash, Regular Contributing Columnist, Sarasota PCUG, Inc., FL  
March 2011 issue, Sarasota PC Monitor, www.spcug.org, Vlabash (at) Comcast.net 
 
Windows 7 has a new and improved version of System Restore that is far superior to the lame utility that 
came with XP.  Setting a restore point was often painfully slow, and it rarely worked as it should have. 
Windows 7 System Restore easily helps you bring back your computer's system files to an earlier point in 
time. It's a way to undo system changes to your computer without affecting your personal files, such as 
e-mail, documents, or photos.   
 
Sometimes, the installation of a program or a driver can cause an unexpected change to your computer or 
cause Windows to behave unpredictably. Usually, uninstalling the program or driver corrects the problem. 
If uninstalling does not fix the problem, you can try restoring your computer's system to an earlier date 
when everything worked correctly. 
 
System Restore uses a feature called System Protection to regularly create and save restore points on 
your computer. These restore points contain information about registry settings and other system 
information that Windows uses. You can also create restore points manually. 
 
System Restore is not intended for backing up personal files, so it cannot help you recover a photograph 
or video that has been deleted or damaged. You should regularly back up your personal files and 
important data using a backup program.  Windows 7 has an excellent built-in backup utility.   

 Windows 7 uses the Shadow Copy feature, introduced in Vista.  It’s vastly 
superior to the process in XP and earlier versions of Windows.  The old way used a 
simple file filter and copied files around the system which was clumsy compared to the 
Shadow Copy method.  Today, Windows creates a snapshot of your drive which can 
later be used to restore your system should catastrophe occur.   
 Additional capabilities of Shadow copy include taking snapshots of files even 
when currently in use.  Microsoft has incorporated this feature into Previous Versions 
which allows restoring a previous version of an application.  Unfortunately, this power is 
available only in Windows Professional or Ultimate.    

 
The easiest way to bring up System Restore is to type System in the Start menu search box and select it 
from the resulting list.  Another way is to select the Recovery option from Control Panel, or you can simply 
type rstrui  in the search box.   
 
Whatever method you choose will bring up the System Restore dialog box that gives you some helpful 
information.  Select the Next button to get a list of restore points.  Most of the time you will be using the 
most recent restore point to get your system working again.   
 
Focus your attention on the Description list.  This can give you an important indication of what went 
wrong.  Did your problem begin after installing a Critical Update, a backup operation, or a new freeware 
program that you couldn’t resist?   
 
When you apply System Restore the system creates another restore point so you can undo the change if 
your problem isn’t fixed.  You can’t undo System Restore however, if you use it in safe mode.  But you 
can run System Restore again and select a different restore point.   
 
Restore points are saved until the disk space Windows allocates to the utility is used up.  Then the oldest 
restore points are deleted as new ones are needed.  The easiest way to delete all previous restore points 
is to turn System Restore off, and then turn it back on again.  Don’t worry about running out of space.   

(Continued on page 7) 
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Many computer problems can be traced to sloppy programs written by people who don’t know enough 
about proper programming techniques to get their utilities published by reliable vendors.  It’s surprising 
how many problems are generated by faulty uninstall tools.  There are many sound freeware offerings out 
in cyberspace, but don’t use them unless they come tested and approved by a trusted source like Smart 
Computing.    
 

 
 
This and That or Things That May Interest You  
By Lynn Page, Editor, Crystal River Users Group, Florida 
December 2010 & January 2011 issues, CRUG newsletter, www.crug.com, newsletter (at) crug.com 
 
Windows Explorer  
Check Boxes  
I use the Control key to make multiple selections in Windows Explorer but you can also use check boxes. 
With Windows 7 in Windows Explorer, click Organize and select Folder and search options in the drop 
down menu. Select the View tab and in the Advanced Settings window scroll down, check the box for Use 
check boxes to select items and click OK. Then when hovering the mouse over a file in Windows 
Explorer, a check box appears next to it. Click the check box to select the file. The checked box remains 
next to the file. Clicking it again removes the check and the box disappears when the mouse is moved 
away.  
 
Windows 7  
Run Multiple Copies of Applications from the Taskbar. If a program is already running, to launch another 
copy of the application from the taskbar, hold down the Shift key and click the icon.   
 
Outlook 2007  
Find Related Messages or Messages from Same Sender  
To find related messages, right-click the message, on the drop down menu select Find All and then select 
Related Messages. The Advanced Find dialog box appears with a list of related messages. To find all 
messages from the same sender, right-click the message, on the drop down menu select Find All and 
then click Messages from Sender. The Advanced Find dialog box appears with a list of related messages.  
 
Color Code Outlook Items  
Color categories can be assigned to items like messages, contacts, appointments and tasks. So color 
code messages, tasks, and calendar items relating to the same project with the same color. For an 
existing item like a message in the Inbox, right-click it, point to Categorize, and click a color category.   
 
Reading Pane  
The Reading Pane lets you read the content of a message, preview and open attachments, follow a 
hyperlink, use voting buttons, view the follow-up information in the InfoBar, and respond to meeting 
requests.  
 
Preview Messages without Opening  
View messages safely in the Reading Pane. Potentially malicious scripts or attachments are not activated 
or opened automatically in the Reading Pane.   
 
View Email Properties  
When viewing a message in the Reading Pane, view email properties about a name in the From, To, or 
Cc field by double-clicking it .  

(Continued from page 6) 

(Continued on page 8) 
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Turn on or Off  
Turn the Reading Pane on or off in the View drop down menu.  
To turn the Reading Pane on in the View menu, point to Reading Pane, and then click Right or Bottom to 
specify where it will appear. To turn the Reading Pane off in the View drop down menu, point to Reading 
Pane and select Off. On the View menu, point to Reading Pane, and then click Right or Bottom. 
 
Preview an Attachment in the Reading Pane  
With the Reading Pane you can quickly see what the attachment contains without opening it. But you 
need the appropriate 2007 Office application installed on your computer.   
 
To Preview an attachment, in the message list, select the message that has the attachment. in the 
Reading Pane, select the attachment and click the Preview file button. To return to the message body, 
click the Message button.  
 
AutoPreview  
Another way to quickly scan through email is using AutoPreview. I personally use AutoPreview only and 
do not have the Reading Pane turned On. It displays the first three lines of each message in the message 
list, along with the sender's name and the subject line. In the View drop down menu, point to Current 
View, and then click Customize Current View. Click Other Settings, and then click Preview unread items.  
AutoPreview and the Reading Pane can be applied to any mail folders, like Sent Items and Drafts, but 
must be set for each folder. 
 
Windows Live Mail  
Options  
Access Mail, Email Account, Newsgroup, Feeds and Safety options through the drop down menus.   
  
Write Messages Offline  
Windows Live Mail saves messages on your hard drive, rather than on the web. So when travelling or 
using an unsecured WI-FI write messages and read those already downloaded while offline. Then 
connect to the Internet to download new email and send messages you have ready and waiting in the 
Outbox. 
 
Add Recipients to Windows Live Mail Contacts  
To add other recipients of an email, right-click on the recipient, select Add to Contacts and confirm the 
details. This works for recipients in the To and CC lists. Right clicking a recipient already in the Contacts 
list offers an Edit Contact option.  
 

 
 
Oracle and the Future of OpenOffice.org 
By Geof Goodrum,  President, Washington Area Computer User Group, VA 
December 2010 issue, The Cursor, www.wacug.org, president (at) wacug.org 
 
Oracle Corporation, a technology company best known for its flagship commercial relational database 
management software, is alienating the Open Source community it once embraced. In 2008, Sun 
Microsystems acquired MySQL AB, the company that developed and provided commercial support for the 
highly popular relational database management system (RDBMS) software, MySQL, which is available in 
both Open Source and commercial license versions. MySQL is very popular (estimated at over eleven 
million installations) as backend software used by web sites world-wide, comprising part of the 
“LAMP” (Linux, Apache, MySQL, PERL/PHP/Python) software stack. 

(Continued from page 7) 

(Continued on page 9) 
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Sun Microsystems is perhaps best known for the Java programming language used to develop software 
that can run on a wide variety of computer platforms. The Open Source community has been pushing for 
the release of control over the Java language specification to the community since at least 2004. In 2006, 
Sun released Java software components under the GNU General Public License, but continued to release 
“non-free” executable versions. 
 
Sun Microsystems also sponsored the OpenOffice.org community project, which developed and 
distributed a free, Open Source productivity suite comparable to Microsoft Office and built upon code from 
the commercial StarOffice product, previously acquired by Sun. 
 
In 2010, Oracle Corporation completed acquisition of Sun Microsystems, including MySQL, Java, and 
OpenOffice.org. During the acquisition, the MySQL community expressed concerns that Oracle would 
discontinue support for MySQL as it competed with Oracle's commercial RDBMS products. While this has 
not happened, Oracle recently doubled MySQL support service costs. 
 
In August 2010, Oracle sued Google over its implementation of Java in the Linux-based Android operating 
system, claiming infringement on seven patents. This move alienated the Java developer community. 
 
In September, a core group of over 30 leading contributors to the OpenOffice.org project formed The 
Document Foundation with support from organizations including Red Hat, Novell, Google, Open Source 
Initiative, Canonical, and the Free Software Foundation. The Document Foundation's primary purpose is 
to support the community development of LibreOffice, a productivity suite built upon the OpenOffice.org 
source code. This move was in response to ongoing concerns about Oracle's governance  
and development process for the OpenOffice.org project, including Oracle's reluctance to accept patches 
to the software. The Document Foundation's stated mission is to  
 
facilitate the evolution of the OpenOffice.org Community into a new open, independent, and meritocratic 
organizational structure within the next few months. An independent Foundation is a better match to the 
values of our contributors, users, and supporters, and will enable a more effective, efficient, transparent, 
and inclusive Community. We will protect past investments by building on the solid achievements of our 
first decade, encourage wide participation in the Community, and co-ordinate activity across the 
Community. 
 
Oracle responded to the formation of The Document Foundation by insisting that members step down 
from their positions on the OpenOffice.org project as it created a conflict of interest. As a result, it appears 
that community developers are migrating from OpenOffice.org to work on LibreOffice. 
 
At this point, it appears that Oracle has squandered whatever credibility it had with the Open Source 
(MySQL, Java, OpenOffice.org) developer community, and the future of the original OpenOffice.org 
project is very questionable.  
 
However, expect to see rapid development and improved software quality for LibreOffice under The 
Document Foundation. 
 

 
 

(Continued from page 8) 
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Broadband2Go 
By John Roy, President, The PCUG of Connecticut, March issue, The Program 
www.tpcug-ct.org, johnroy1 (at) comcast.net 
 
I have been itching to purchase an AirCard® for my laptop computer. We take several trips during the 
year with our Roadtrek motor home and, while Wi-Fi hotspots are more abundant these days, Instant 
Internet access is really appealing. Unfortunately for this instant gratification you have to pay a big price. 
Being frugal I wasn't prepared to commit to a two-year contract at $60 per month for the privilege. 
 
For those of you not familiar with an AirCard, it is a high-speed wireless broadband card that gives users 
mobile Internet access on their laptops, using a cellular data service. AirCards can be purchased from 
wireless providers in various styles such as USB, PCMCIA, ExpressCards and as a portable router. It's 
interesting to note that AirCard is a registered trademark but used generically to describe these devices 
such as we use Xerox and Kleenex. 
 
Last year my daughter needed daily email and texting capability that her present cell phone did not 
provide. She already had an iPod Touch but Wi-Fi hotspots were limited. I researched various options to 
find a minimal cost solution and focused on Virgin Mobile's Broadband2Go MiFi 2200 credit card router. 
The driving factor was Virgin Mobile had the cheapest data plans without any contract obligations. 
 
The MiFi 2200 router is unbelievably small just like a credit card and can serve five computers at the 
same time. There is an initial cost of $150 for the device but then you can buy air time to fit your needs. 
This device is extremely portable and will run four or more hours without a recharge. 
 
After monitoring my daughter’s success with the MiFi 2200, and knowing we were taking an extended trip 
with our motor home, I decided the time and price was right for my purchase. Virgin Mobile sells two 
broadband products with the same data plan options. In addition to the $150 MiFi 2200 they sell a $80 
USB MC760 device. The MC760 plugs into any USB port but unlike the MiFi router it is dedicated to the 
one computer. 
 
After reviewing the pros and cons for my situation, I chose the MC760. I didn't have a need for sharing my 
hotspot with five computers, the USB device didn't require a battery, and I saved myself $70. Of course 
the best part is I was not locked into a contract and could buy time as needed.  
 
Is buying an AirCard from Virgin Mobile a "no brainer" for everyone? The answer is no but it should be on 
everyone's evaluation list. Here are some key considerations beyond the primary driver of saving money. 
Their cellular service is the Sprint 3G network with good coverage in populated areas or primary highway 
corridors but poor coverage in other less populated areas. You should check their coverage map to be 
sure you will have a good signal for your specific needs. 
 
There is some good news and a little concern on their data plans. Last year they offered a $10 (10 day 
100MB) and a $40 (30 day unlimited) plan. This February they increased the $40 plan to $50 and put 
some speed restrictions beyond 5GB but the deal is better than competing providers. While the price hike 
was concerning, there is an unpublicized secret you should know. If you purchase either device from Wal-
Mart you are offered an optional $20 (30 day 1GB) plan. 
 
How the plans work is when you start using a plan it will end when either the time period or data limit is 
met. On the $50, 30-day unlimited data plan when you reach 5GB of data use your speed will be limited to 
256kbps for the remainder of the time period. 

(Continued on page 11) 
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One final note is both devices have several neat software options beyond the basic application.  
 
The MC760 has a micro SDHC memory card slot and the capability of adding an optional antenna to 
increase range. Documentation is less than meager and only includes startup instructions but once 
initiated the setup is interactive. Most importantly you can find a detailed manual on line. If you are in the 
market for an AirCard or curious for more details, visit their website. 
 
http://www.virginmobileusa.com/mobile-broadband/ 
 

 
 
 

 
 
“The technician set up my laptop, now what do I do? ” 
By Gregory West, Member of the Computer Operators of Marysville and Port Huron, MI, and Sarnia Computer User 
Group, Canada, http://gregorywest.wordpress.com/, prospector16 (at) gmail.com 
 
Ah, the wonderment of getting a new computer. No more having to watch others show off their computer 
skills as they demonstrate their new digital slide show, or listen about how they talk with relatives across 
three oceans for hours at no cost. With your new computer you are ready to join the online communities 
around the globe. 
 
Three gigabytes of random access memory, 500 gigs of hard drive, a one year subscription to some 
antivirus / malware protection software utility and you are “good to go,” says the clerk in the computer 
store. 
 
“But does it come with a manual,” you ask? 
 
“The manual is in the OS software,” the clerk says as he gets you to sign his copy of the credit card slip. 
“Have a nice day,” he hollers as you lug the computer through the doors towards home. 
 
“Ya right,” you mutter under your breath 
 
So many choices, too many decisions, but at least you finally got it home. Once you open the lid and go to 
turn on the new computer you realize that you have no idea what you are doing. In fact, you don’t know a 
gigabyte from a Tyrannosaurus Rex, and you couldn’t care less. All you want is to go on the Internet and 
check your email, surf some websites and maybe learn how to get those 265 photos from your digital 
camera. 
 
“So now what,” you say aloud to yourself? “Where do I begin,” you ask your dog in desperation as she 
gives you that puzzled look. 

(Continued from page 10) 

(Continued on page 12) 
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There is an easy way to learn the various computer functions you need to catch up with your computer 
geek of a neighbour. First, you can take a formal course at your local college. These courses usually range 
from beginner to advanced. You can also take online courses (courses offered over the Internet), but this 
takes a special skill, as many people are not used to working alone and need to get out into a classroom 
set up with real humans. You can also join a local computer group. Here you will find people with similar 
interests who provide various seminars on tech-related issues. 
 
I have been on a computer since 1972 where an IBM System/360 Operating System was the popular 
system in data processing centres. Over the years I have received computer training from all methods 
mentioned about. In fact, today I am taking two computer courses from books that came with DVD training 
programs 
 
However, if you simply need to know one certain function on the computer, learn a software program, or 
how to troubleshoot a problem in your computer, I suggest Google’s YouTube videos. Computer 
instructors, tech companies, libraries, schools and many knowledgable individuals upload training videos 
to YouTube. Here you not only get free training, but targeted training. For instance, if you need to know 
how to install a USB flash drive in Windows 7, you simply go to youtube.com on the Internet and there will 
be many videos to help you through this process. 
 
One tip for searching within YouTube for help, try using the term: “tutorials” with your search. Sometimes 
this will give you a full training course on the particular subject you are interested in learning. I use 
YouTube all the time when I need help with a particular computer program. But it doesn’t stop there either. 
I wanted to learn how to winterize my RV and save the hundred dollar fee, so I searched for videos on 
YouTube and have winterized my own trailer ever since for only the cost of antifreeze 
 
Gregory West is a Mac Instructor for Lambton College. He is also Webmaster at Central United Church, the home of 
Sarnia’s new Community Computer Training Centre at: http://goo.gl/76H15. This is free and open to the public as a 
community service. Learn at your own speed. 
 

 
 
THIS AND THAT  
By Elizabeth B. Wright, Member, Computer Club of Oklahoma City 
February 2011 issue, CCOKC eMonitor, www.ccok.org. wright599new(at)sbcglobal.net 
  
Last Fall my husband and I were part of a tour group which visited several countries. The most amazing 
part of the trip was how many of our fellow passengers had brought laptop computers and Kindle book 
readers. Since nearly all of us had digital cameras, we used our computers to download the images after 
each day’s adventure. That gave us some reassurance that even if our cameras had been lost or stolen, 
the downloaded images would be safe on the computer. We were able to leave our computers in the care 
of the tour company while visiting the various sites of interest. Then we would have them with us later in 
our hotel rooms. The smartest thing I did was take with me a very small ACER Netbook and a very small 
Seagate 500G external drive. Also several USB flash drives for extra storage. The netbook computer was 
so much easier to carry than a full sized laptop, and all I needed it for was photo downloading and email. I 
did not try to do any photo enhancing or editing while still on the road. That was saved for my return home. 
And here it is January, and I still haven’t finished!!  
 

(Continued from page 11) 

(Continued on page 13) 
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It is a bit difficult to explain how I nearly lost some of my pictures, but here goes. We took four cheap point 
and shoot cameras with us on the trip. Three of them used SD memory cards. At some point during the 
trip at least one card was interchanged between two of the cameras. In addition to that confusion, 
somehow the numbering system was duplicated in two of them, causing pictures with the same numbers 
appearing on two memory cards. Somehow, almost surely because of the daily downloading procedure, 
both sets of numbered images were salvaged. It took me quite a while after we returned home to figure 
out the problem and actually retrieve all of my images. At least I think they are all accounted for.  
  
My personal accessories included, in addition to the still cameras, a newly purchased FLIP video camera. 
It has limited memory, so each day I not only downloaded the videos but also erased them in the camera. 
This was a bit risky, and I am not too sure some videos were not lost. I don’t remember taking any that I 
can’t find, but it is possible. In my defense, most of my videos were not any good anyway. Word of advice: 
If you are going to travel with a new device, purchase it far enough in advance to learn how to use it. If I 
could do it over again, a small hand-held tripod would have been very useful for stabilizing the camera as 
well as keeping my clumsy fingers off of the very sensitive controls. Amazingly, the videos are of very high 
quality for such a small device, so even though mine are not particularly good, it should be possible to lift 
some still shots from them to use with the rest of the still  pictures we took.   
  
Upon returning home, I copied all of our pictures, even the bad ones, to flash drives and gave them to our 
son. Not only will that give us a backup if something happens to our computers, but he actually wants to 
look at them. That is the greatest compliment of all.  
  
 
 
HOVER CRAFT  
  
I recently received one of the slickest SPAM emails I have ever seen. The website was made to resemble 
a Microsoft offering, complete with pictures of products that looked like Microsoft Office programs. But 
when you hovered over the link, it did not go directly to Microsoft.   
 
Hovering is NOT clicking. Remember this. When you hover the mouse pointer over the link, i.e. placing the 
mouse over the link on the screen but not pressing any buttons, it should produce the actual link at the 
bottom of the screen. Using our club webpage as an example, pretend the fancy arrow is your mouse 
pointer and that it is hovering over the option to view details for Randy’s study group. (The real mouse 
arrow does not show in a “printscreen” image.) At the bottom of the page, under the curved arrow, is the 
actual web URL which will transfer you to the page containing the information for the group. It is in very 
small print and hard to read, but it is there. It says:  
 “Go to http://www.ccokc.org/documents/Win7_Resources.pdf (http://bit.ly/h2TmCh)” 
and the quotes are included in the URL.  
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In the case of the suspicious website, the URL address contained some words after the initial part of the 
link, including “Microsoft,” which would again lead you to believe it was a legitimate Microsoft offering. If 
this had been truly from MS, I think that company’s web address would have been in the first part of the 
link, in other words “microsoft.com”. Since the Golden Rule is to never click on links incorporated in 
unsolicited email, I decided the offering was SPAM and deleted the email from my web server, never to 
be seen again (hopefully).   
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    Membership  Enrollment  Form        
 
       NAME  _______________________________________           PHONE  __________________ 
 
       ADDRESS  ___________________________________________________   
 
       CITY    __________________              ZIP  _______________       
 
        EMAIL ADDRESS     ___________________________________________ 
 
       Membership dues   FAMILY ($20)      STUDENT ($15)     New Member ____    Renewal   ____ 
 
                     Please fill out the above form and mail it along with payment of check or money order to : 
 
           MIDLAND COMPUTER CLUB         Attn: Memb ership Chairman 
              1816 Bauss Ct 
             Midland, MI  48642-4023   
                                                                      You may also pay for membership at a regular club meeting 


